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COMPUTER

Ch-1 (Computer Network)

Upskills your intelligence

1. modem 2.hardware 3.phishing, datatheft 4.size, purpose 5.geographic

1.F 2.T 3.T 4.F 5 L

1. An organisation can benefit greatly from a computer network in a number of ways.
Here are some advantages of'a computer network.

(i) Saves cost (ii) Reduces data redundancy (iii) Sharing resources (iv) Security

2. Local Area Network: The Local Area Network is confined to a limited area, such as

a room, an office building, etc. As the area covered by LAN is limited, the data
transmission speed in LAN is very fast.
Metropolitan Area Network ( MAN): A metropolitan area network consists of a
computer network which covers an entire city. As compared to LAN, it covers a
wider area. ATM machines of a specific bank, installed at different locations in a city,
are an example of MAN.

3. The network topology is an organisation of diverse network components in a way
that makes communication simple and easy. Before you start with the arrangement
of network components, It's crucial to establish the logical topology—also known as
the information flow between network components.

4. In Client-Server Network, several Computers called clients are connected to the
main computer called the server. A computer that serves clients and manages access
to hardware, software, and other resources is known as a server. The computers that
ask the server for services like data retrieval, storage, etc. are known as clients.

5. Wide Area Network: A wide area network occupies a very large area, such as an
entire country or the entire world. It consists of many smaller networks, such as
LANs or MANSs. The primary characteristic of WAN is that data transfer requires a
public telecommunications medium. A very common example of WAN is the
internet, wherein millions of computers are interconnected with each other.

Critical thinking: Ask students to do it by themselves.

Team work: Ask students to do it by themselves.

Ch-2 (Log on To Access)
Upskills your intelligence
1.advanced 2.decision-making 3. Databases 4. storage location
1.T 2.F 3.T 4.F 5.T
1. Microsoft Access is the most popular and powerful (RDBMS Relational Database
Management System) that serves as an integral part of the Microsoft Office Suite

Application. It is employed to effectively organise and manage massive amounts of
data.
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2. Components of Microsoft Access 2016:

Title Bar: The name of the current database is displayed on it, at the top of the
window.

Quick Access Toolbar: This is found in the Access window's upper left corner. It
comes with three buttons by default: Save, Undo, and Redo.

Ribbon: It has numerous tabs, each of which has a number of groups of relevant
commands. Such tabs are called Contextual tabs.

Status Bar: On the extreme left, it displays the name of the current view and on its
right, it displays four view buttons, which are Datasheet view, Design view,
PivotTable view and PivotChart View.

Object Tabs: It displays the elements you've opened in tabbed form. The contents of
the components in the Work area are displayed when you click on any tab.

3. Steps to create a blank database.

Step 1: Click on the Blank database option.
Step 2: In the file, the name field enters a name for the database.
Step 3: Click Create.
4. Creating a Table In Design View:
(1) In the Field name, add a column name for the table.
(ii) Select an appropriate data type for the field from the Data Type drop-down list.
(iii) Add the text in the description to enter a few more details about the field.
(iv) Save the table by clicking on the Save option in the File tab.

5. Primary key is a standard feature of every database management system which is
used to identify each record of a table uniquely. The field which is designated as the
Primary key of a table neither can have duplicate data nor it can be left blank while
entering the data.

Critical thinking: Ask students to do it by themselves.

Team work: Ask students to do it by themselves.

Ch-3 (Working with Queries, Forms and Reports)
Upskills your intelligence

A. l.sequential 2. form 3. operational
4. Navigation 5.Aform's record navigation bar
B. 1.T 2.T 3.T 4.F 5.T

C. 1. A form is a device for gathering data in a sequential style. Frequently, whoever
creates the form has all the necessary fields for the required data.

2. Ways to Formata Form:
(1) Changing Themes and Fonts of a Form
(i1) Inserting Date and Time to a Form
(iii) Arranging the Order of the Fields in the Form
(iv) Adding a Background Image to a Form
3. Stepsto create a form:
(1) From the Navigation Pane, choose the table.
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(i1) Click the Form button in the Forms group after selecting the Create tab from the
ribbon.

(iii) A new form has been created; notice how the ribbon's options have changed and
how the Design tab is now active.

(iv) Click the Home tab and then the view button displayed in the Views group to

input or edit records in the form. Go to the drop-down menu and choose Form View.
4. Creating Query with Query Wizard:

(i) Select the “create” tab. In the Queries group, click the Query wizard button.

(i) The New Query dialogue box appears. By default, the Simple Query Wizard
option is chosen. Click OK to continue.

(ii1) As illustrated below, the wizard will now ask us to choose the query table and the
fields inside it that we want to include in the query.

(iv) We will be asked to enter the query title in this final step.

5. Areport is a useful tool for organising and summarising data which can be created
exactly the same as we have created the form.

Areport can be created exactly the same as we have created the form.
Critical thinking: Ask students to do it by themselves.
Team work: Ask students to do it by themselves.

Ch-4 (Cloud Computing)
Upskills your intelligence
1. subscription 2.email 3.Small 4.storage 5. private cloud
1. T 2.F 3.T 4.F 5: T

1. Cloud computing is a service that requires a subscription and includes a number of
services. These services are used by individuals and organisations. Because all of the
processes take place in the internet world, it is known as cloud computing.

2. Different types of cloud services are available depending on the needs of the users.
(1) Public Cloud
(ii) Private Cloud
(ii1) Community Cloud
(iv) Hybrid Cloud
3. The disadvantage of Cloud Computing

e We have little to no understanding of where our data is stored, and we have
limited control over who has access to our information.

e Qurdatais frequently accessed by hackers without our permission.

4. The following considerations should be made by a user before choosing a cloud
service.
e Whatkind of encryption does the provider use?

e What methods of protection do they have in place for the actual hardware that our
data will be stored on?

e Do they have duplicates of our data on hand?
e Do they have firewalls setup?
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e What safeguards are in place to prevent a user's information from being shared
with other users if they have a community cloud?

5. Dropbox: One of the best cloud services for sharing files is Dropbox. It offers its
customers SaaS-based services.

Google GSuite: The most widely used email application in the Google Play Store is
Gmail, a free online email service.

Critical thinking: Ask students to do it by themselves.
Team work: Ask students to do it by themselves.

Ch-5 (Introduction To Arduino)
Upskills your intelligence
A. l.integratedcircuit  2.input 3.microcontroller 4. digital 5. code editor
B. L.T 2.T 3.T 4.F 5.T
C. 1. A microcontroller is a compact integrated circuit designed to govern a specific

operation. A typical microcontroller includes a processor, memory and input/output
(I/O) peripherals on a single chip.

2. Parts of an Arduino
Built-In LED: Whether your Arduino is delivering or receiving data is indicated by
the LEDs labelled TX and RX.
Digital 1/0 Pins: The holes on this side of the board are called the digital input/
output pins. They are either used to sense the outside world (input) or control lights,
sounds or motors.

3. Analog Pins: Instead of providing a simple on/off signal, these pins take sensor
measurements throughout arange of values.

4. IDE stands for Integrated Development Environment. It's a coding tool which
allows you to write, test, and debug your code in an easier way.

5. Difference between an Arduino and a normal computer:

Arduino Computer
1. The Arduino is a programmable 1. Acomputerisamachine oradevice
microprocessor/microcontroller. that performs operations based on

instructions provided by a software

or hardware program.

2. The Arduino can perform only one 2. Acomputer can run multiple
oraspecific program. applications.

Critical thinking: Ask students to do it by themselves.
Team work: Ask students to do it by themselves.

Ch-6 (Looping Statements in Python)
Upskills your intelligence
A. 1.condition 2.three 3.traversal 4. infinite 5. Continue Statement
B. 1. While Loop 2. While Loop 3. Traversal 4.ForLoop 5. Break Statements
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C. 1. Theidea of'a loop enables us to execute programme instructions repeatedly without
having to repeatedly write the same ones. The successful execution of the loop
depends on the condition.

For Example, Mother gives you a bowl of rice. You won't eat it up at once. You start
with the first spoon, then the second and so on. In this manner, you finish your rice
after several tablespoons of eating.

2. If a condition never evaluates to FALSE, a loop becomes infinite. It occurs because
the loop either lacks a terminating condition or has a requirement that can never be
satisfied. As aresult, anever-ending cycle is created. It is known as an infinite loop.

3. Difference between for loop and while loop:

Forloop While loop
1. The for loop is used to repeatedly 1. Inthewhileloop, if the specified
iterate over a sequence's values. condition is true, a series of
statements will be carried out.
2. The'forloop'is also called a 2. It'sreferred to as a conditional loop.
counting loop.

4. Askstudents to do it by themselves.

5. Continue Statement: This command causes the loop to skip the remaining portions
of its body and to retest its condition right away before updating the loop variable.

Critical thinking: Ask students to do it by themselves.

Team work: Ask students to do it by themselves.

Ch-7 (Robotics)
Upskills your intelligence

A. l.artificial intelligence 2. bionic prosthesis 3. Sensors
4.hazardous, dangerous 5. Robotics
B. 1.F 2. T 3.F 4. T 5.F

C. 1. Robots are artificial agents that behave in the real world. They can carry out the tasks
that a person gives them. Robots are equipped with sensors that can recognise and
pick up on physical information from the outside world, such as heat, light,
temperature, pressure, sound, bumps, and movement.

2. Features of a Robot:

e Arobot absorbs information about its surroundings and makes use of that data to
carry out tasks as directed.

e It functions according to the programs installed in it and the programs can be
changed accordingly.

e Robots have sensors which enable them to see even in dark as well as detect the
small movements which a normal person is not able to do.

3. Types of Robots:
(i) Aerospace Robots (i1) Consumer Robots

(iii) Disaster Response Tools  (iv) Industrial Robots  (v) Medical Robot
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4. Applications of robotics:
e Conservation: fighting forest fires.
Manufacturing: working in factories, finding and carrying items in warehouses.
Companionship: providing company to elderly individuals.
Healthcare: assisting in surgical procedures.
Delivery: completing food delivery and last-mile fulfilment.
Household: vacuuming and mowing the grass.

Rescue: undertaking search-and-rescue missions after natural disasters.

Military Operations: detecting landmines in war zones.

5. Robots used in disaster response do hazardous or dangerous duties.
Robots are widely used in manufacturing, assembly and packing.

Critical thinking: Ask students to do it by themselves.

Team work: Ask students to do it by themselves.

Ch-8 (Cyber Ethics)
Upskills your intelligence
A. 1.computerethics 2.unauthorised 3. Hackers 4.important 5. False
B. 1.T 2.F 3.T 4.F 5. L
C. 1. Cyberstalking is the recurrent practice of unwanted monitoring or harassment with
the intent to manipulate or influence the victim. Online and offline stalking are both
against the law.

2. Identity theft is a type of cybercrime in which the culprit creates a false identity in
order to obtain financial benefits like credit cards and loans, among other things.

3. Spamming involves sending the same messages to email users all over the world in
millions. Since spam may be used to spread malware such as trojan horses, viruses,
worms, spyware, and coordinated targeted phishing attempts, it poses a major
security risk.

4. Some points to keep in mind while accessing a website:

e When using the websites, use common sense.

e Verify the website's address, contact information, and email address to ensure its
legitimacy.

e The URL of the website might look authentic. Keep an eye out for slight spelling
variations.

e Use the mostrecent versions of your browser and antivirus software.

e Alwayskeep in mind to log out of the website after finishing your transaction.

5. Any computer that is connected to the internet is exposed to a wide variety of
technological dangers. Cyber security tries to protect sensitive data, computer
security, confidentiality, integrity, and accessibility of important data kept on
computers.

Critical thinking: Ask students to do it by themselves.

Team work: Ask students to do it by themselves.
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Ch-9 (Introduction to App Development)
Upskills your intelligence

1. operating 2. native 3. design 4. operating system 5. Web
I.F 2.T 3.T 4.T 5.F
1. Difference between Native and Web apps:

Native Web apps

1. Native apps are created expressly 1. Appsthat canbe used witha web
foran operating system on a browser are referred to as web apps.

mobile device.

2. Take up much space in the device. 2. Itdoesn't occupy space in the device.

3. Itis expensive to maintain. 3. Itiseasy to maintain.

2. Choosing the right app: Apps are chosen according to the following features.
(i) DevelopmentTime  (ii) Limited Resources  (iii) Performance

3. Thunkable is a web-based application that was first made available by Google and
has an integrated development environment. Anyone with basic computing skills
candevelop Native apps that are based on Android and iOS.

4. Creating App with Thunkable:
Steps:
(1) Scroll down to the Image tool in the design section.
(ii) Place the picture tool in the Layout Screen by dragging and dropping it there.

(iii) Choose a picture from the Image panel on the right side of the screen. Utilise the
Upload files option to upload an image from your PC.

(iv) As soon as the picture has been added to the layout screen. On the Layout Screen,
you can drag and drop it to reposition it.

(v) Scroll down and choose the Label tool in the Design section. Drag it down and
drop it next to the picture.

(vi) From the labell panel shown on the right-hand side of the browser screen, click
on the Text option and add text of your choice in the textbox.

(vii) Scroll down and choose the button tool in the Design section. Drag it down and
drop it just below the label.

(viii) From the button panel, click on the text option and add the text of your choice in
the textbox.

5. Web apps and native apps are combined to create hybrid apps. These apps can be
loaded on a device much like native apps and have a user interface similar to a web
app. Apps thatare hybrids can be acquired from the iOS or Play stores.

Critical thinking: Ask students to do it by themselves.
Team work: Ask students to do it by themselves.

Ch-10 (Sound Editing With Audacity)
Upskills your intelligence

1.28,2000  2.user-friendly 3.zoom 4. Combining 5. Import
1.F 2.T 3.F 4.T 5.F

8
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C. 1. Audacity is a free open-source programme that enables you to edit and record audio.
Audacity was released on May 28, 2000.

2. Audacity is a free open-source programme. The most recent version of Audacity is
readily available online.
Open the browser application on your computer and type the URL displayed below
in the address field to download Audacity. www.audacityteam.org

3. Audacity is a cross-platform app, that allows you to install it on devices running
Windows, Linux, or Mac OS operating systems.

4. Steps to import audio to Audacity.

(i) Select Import from the menu selections by clicking on the File menu, and then
choose the Audio option.
(i) Find the track you want to import in the select one or more files dialogue box.
When the desired track has been chosen, select Open to bring it into Audacity.

5. (i) Utilizing Audacity Timeline's import function, add a track.

(i) Choose the section of the track where the effect should be applied using the
Selection Tool from the Tools Toolbar.

(iii) Press the Ctrl-A key combination to add effect to the entire track.

(iv) Now select the Echo menu option by clicking on the effect menu. (v) The chosen
section of'the track will immediately receive the Echo effect.

(vi) Using the instructions above, you can apply a variety of different effects to your
audio file.
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